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1 Getting Started 44 

The 1 pixel wide green bar (Figure 1) provides access to a number of different system 45 

views. To get started, first make sure that the correct desktop is displayed (Figure 1). 46 

To access the correct display:  47 

 48 

 49 

To launch the Surface Trajectory Based Operations (STBO) Client:  50 

 51 

Step 1: Hover over the green bar to populate the menu. 

Step 2: Select “My Desktop” from the top of the menu to access the correct 

display.  

 

Figure 1. Use the green bar tool to navigate to “My Desktop”. 

Step 1: Click on the NASA icon on the bottom left corner to launch the menu 

on the toolbar (Figure 2). 

Step 2: Select the option for the STBO Client. 

Step 3: Wait for the STBO Client to load. This may take a few minutes. 
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  52 

 

Figure 2. Loading STBO Client. 



 

ATD2_1029_v1_STBO_Client_Obs_UM last updated 15 Sep 2017 page 5 of 80 

2 STBO Client Interface 53 

This section describes the elements of the STBO Client main interface (Figure 3) and 54 

ways to interact with them.  55 

 56 

The full interface of the STBO Client is composed of multiple display windows that serve 57 

different purposes and can be arranged in any desired configuration. 58 

The Toolbar allows the user to interact with the system by adding new display windows, 59 

managing current display windows, saving and loading user configuration preferences, 60 

searching for flights, and displaying new notifications to the user. 61 

The Timelines provide information about the predicted OFF times for departures, 62 

predicted ON times for arrivals, gate conflicts, and aircraft that are subject to TMIs.  63 

Datablocks on the Timelines can be configured to show flight-specific information. 64 

The Map displays surface surveillance data and provides a visual representation of 65 

aircraft current positions. The Map also displays runway closures. Datablocks on the Map 66 

can be configured to display flight-specific information. 67 

The Flights Table is a list of all known arrivals and departures within the next 6 hours for 68 

the airport. The list can be sorted and filtered according to the user’s preference, and 69 

information columns can be moved, added, and removed. 70 

  71 

 

Figure 3. The elements of the STBO Client interface. 
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2.1 Timeline 72 

The Timeline (Figure 4) is set up to display flight location, reference labels (e.g., 73 

“18C/36C”) at the top and bottom of the display, the reference point (e.g., “RWY” at the 74 

bottom), the title at the top of the Timeline, and the Now time. The Timeline also 75 

provides information about arrivals, departures, TMIs, runway assignments and changes 76 

for operational necessity, gate conflicts, and pushback and taxi status.  77 

 78 

The location on the Timeline reflects the Surface Time Based Metering (STBM) 79 

algorithm prediction of OFF time for departures and ON time for arrivals. For departures, 80 

this is either the Target TakeOff Time (TTOT) or Earliest Feasible Takeoff Time (EFTT).   81 

 EFTT is only provided for APREQs that have yet to be negotiated with Center.   82 

 TTOT is a prediction of OFF based on Target Off-Block Time (TOBT) and 83 

predicted taxi times. For flights with Expect Departure Clearance Times (EDCTs) 84 

or Approval Requests (APREQs) / Call for Releases (CFRs), the TTOT may 85 

equal the Controlled TakeOff Time (CTOT). 86 

 

Figure 4. The STBO Client Timeline. 
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When flight datablocks cross below the reference line with the Now time, arrivals have 87 

landed and departures have taken off.  88 

To create additional Timelines: 89 

 90 

The new Timeline will appear with default Timeline datablocks. The overall layout of 91 

Timelines, Maps, and Flights Table can be saved via the Settings menu on the STBO 92 

Client Toolbar (see section 0). 93 

2.1.1 Timeline Elements 94 

When the Timeline is configured by arrivals and departures, arrival flights are displayed 95 

in grey (Figure 5), and departure flights are displayed in green.  96 

 97 

All TMI information is displayed in white text. For APREQ/CFR flights, the word 98 

“APREQ” is initially displayed in white text. When the APREQ flight receives a release 99 

time in the system, APREQ/CFR times are displayed on the Timeline in white text (e.g., 100 

“A:2250”). APREQ/CFR flights have additional symbology (e.g., the telephone icon in 101 

Figure 5) that is described in section Error! Reference source not found.. 102 

When parking gates are displayed on the Timeline, any unknown parking gate 103 

assignments are displayed as “UNK.” When gate conflicts are displayed on the Timeline, 104 

the parking gate number is colored magenta for flights with gate conflicts.   105 

Step 1: Click on “Create” on the STBO Client Toolbar. 

Step 2: Select “Create Timeline”. 

 

Figure 5. Various elements of the Timeline. 
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When Ramp inputs a requested change of runway assignment for operational necessity 106 

(see RTC_User_Manual.pdf), the flight datablock moves to the portion of the Timeline 107 

dedicated to the new runway assignment and “OpNec” (operational necessity) is written 108 

in light green text on the right side of the Timeline datablock (AAL1810 in Figure 5). 109 

Additional flight information can be configured to display on the Timeline datablocks 110 

(see section 2.1.2). 111 

2.1.1.1 Leader Lines 112 

Leader lines (Figure 6) are useful for determining the status/position of the flight on the 113 

surface.  114 

 115 

 Leader Line 

Color 

Description 

Orange Show untracked departure flights that are scheduled but have not 

yet pushed off the gate (no OUT time) 

Dark Pink Show untracked departure flights that have pushed back from the 

gate (have an OUT time) 

Blue Show tracked departure flights that are still in the Ramp area 

Green Show tracked departure flights that are in the Airport Movement 

Area (AMA) 

Grey For arrival flights (see right side of the Timeline in Figure 6) 

 116 

2.1.2 Timeline Settings 117 

Timeline display windows are not limited to showing information about arrivals and 118 

departures to the runway. Timelines can be configured for other reference points, to input 119 

 

Figure 6. Timeline leader lines. 
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different data, to have color coding beyond that of arrivals and departures, be filtered to 120 

display select information, and can be shown in list format rather than as a Timeline. 121 

Timelines can also be configured to show a variety of information in the datablocks about 122 

arrival and departure flights.   123 

To open the Timelines configuration window: 124 

 125 

  126 

The “Timeline Settings” options will open the Timeline Settings window (Figure 7). Use 127 

this window to alter the Timeline. Once the desired changes are input into the Timeline 128 

Settings window, click the “Ok” button at the bottom of the window to apply the changes 129 

and close the Timeline Settings window. To exit the window without applying changes, 130 

click the "Cancel" button at the bottom of the window, or click the window close "X" 131 

button in the upper right corner; this must be done without clicking “Ok” in order to 132 

prevent changes to the current Timeline configuration. 133 

2.1.2.1 Labels 134 

Within the Timeline Settings window, the title of the Timeline window and the reference 135 

labels for the left and the right side of the Timeline can be changed.  136 

To change the title: 137 

 138 

Step 1: Right-click anywhere on the Timeline background (anywhere not on a 

flight datablock) (Figure 7). 

Step 2: Select “Timeline Settings”.  

 

Figure 7. Right-click on the background of the Timeline to open the Timeline Settings window. 

Step 1: Edit the content of the "Title:" text box (Figure 8). 

Step 2: Then click the “Ok” button. When the change is applied, the title on 

the top of the window will change (Figure 4).  
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 139 

To change the label for the left side of Timeline: 140 

 141 

To change the label for the right side of Timeline: 142 

 143 

2.1.2.2 Reference Point 144 

The reference point is the point from which flights are scheduled or predicted on the 145 

Timeline. For example, if a flight is 10 minutes away from the Now time on the Timeline 146 

(Figure 2), then the flight is 10 minutes away from reaching the reference point. If the 147 

reference point is a runway, the flight is 10 minutes away from taking off on the runway; 148 

if the reference point is the spot, the flight is 10 minutes away from reaching the spot. 149 

 

Figure 8. Timeline Settings window for the STBO Client Timeline. 

Step 1: Edit the content of the "Left Label:" text box (Figure 8). 

Step 2: Then click the “Ok” button. When the change is applied, the left 

labels at the top of the Timeline (Figure 7) and at the bottom on the reference 

line will have changed. 

 

Step 1: Edit the content of the "Right Label:" text box (Figure 8). 

Step 2: Then click the “Ok” button. When the change is applied, the right 

labels at the top of the Timeline (Figure 4) and at the bottom on the reference 

line will have changed. 
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Changing the reference point in the Timeline Settings window changes the reference 150 

point for both sides of the Timeline.  151 

To change the reference point: 152 

 153 

154 

 155 

 156 

2.1.2.3 Setup Filter 157 

Adjusting filters for the Timeline can help to refine the information displayed on the 158 

Timeline. The filters are how to set specific resource to display on each side of the 159 

Timeline. For example, the filter can be used to display runway 5/23 data on the left side 160 

of the Timeline and runway 18L/36R data on the right side of the Timeline. Filters can 161 

also be used to set up Timelines to show flights with only certain TMIs, like APREQs. 162 

Step 1: Click on the "Ref Point:" drop-down list arrow (Figure 9). 

 

Figure 9. Timeline reference point. 

Step 2: Select a new reference point from the drop-down list. 

Step 3: Click the “Ok” button. When the change is applied, the reference 

point indicators on the bottom of the Timeline on the reference line will 

change (Figure 10). If no other title is specified, the title on the top of the 

Timeline will also change. Timeline datablocks will also have shifted up or 

down on the Timeline depending on where the new reference point is 

physically located relative to the old reference point. 

 

Figure 10. Timeline reference point and title labels. 
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To change the Timeline filters: 163 

 164 

Note that changing the filters does not automatically update the labels. To update labels 165 

to reflect the resource (e.g., “18L/36R”), see section 2.1.2.1. 166 

 167 

Step 1: To add filters to the Timeline, click on the "Setup Filter" button 

(Figure 8). The Filters window will open (Figure 11). 

Step 2: The window will allow for applying filters to the left and right side of 

the Timeline separately. Choose either the "Left" or "Right" tab to set filters 

for the left or right side of the Timeline respectively. 

Step 3: Select a resource from the "Field" drop-down list (e.g., "Runway"). 

Step 4: On the same row, select a modifier from the “Operator” drop-down 

list (e.g., "="). 

Step 5: On the same row, select a more specific resource (e.g., "18L"). 

Multiple specific resources can be selected for a single resource category and 

modifier. 

Step 6: If more resources need to be included in the filter, make entries on a 

new row. Begin these entries by selecting a qualifier from the qualifier drop-

down list (e.g., "AND"). Complete the entries in the new row in the same 

manner as described in steps 3-5. 

Step 7: Once all desired entries are complete, click the "OK" button at the 

bottom of the Filters window.   

Step 8: Click the "Ok" button on the Timeline Settings window (Figure 8). 

The Timeline will now only display flights that match the filter. 
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 168 

2.1.2.4 Left and Right Data 169 

Two types of data can be populated on the Timeline. Changing the type of data will result 170 

in different positions of Timeline data blocks (Figure 12).  171 

 “Undelayed” data is the earliest time that the flight can reach the Timeline’s 172 

reference point as computed by STBO based on predicted trajectory, a constant 173 

rate of speed in the Ramp, and a constant rate of speed in the AMA. No other 174 

flights are considered in this calculation. This time updates every 10 seconds. 175 

 “Latest” data populates Timeline datablocks based on the most up to date 176 

information for a flight.  177 

o If the actual event (e.g., landing, pushing back, etc.) has occurred, this is 178 

the time the event occurred. The data source is from Airline, Terminal 179 

Flight Data Manager (TFDM), Traffic Flow Management (TFM), or 180 

computed by the Model. 181 

o If the actual event (e.g., landing, pushing back, etc.) has not occurred, this 182 

is the target time from the scheduler. 183 

 

Figure 11. Timeline Filter. 
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To change the data that's used to populate the Timeline (using “Right Data” as the 184 

example): 185 

 186 

 187 

2.1.2.5 Format 188 

The Timeline can be setup to display as either a Timeline or as a list. The Timeline places 189 

the Timeline datablocks for flights at the point on the Timeline where each flight is 190 

expected to reach the reference point. The list format does not space the Timeline 191 

datablocks; it instead lists all of the flights in the order in which they are expected to 192 

reach the reference point without what considering the specific time they are expected to 193 

reach the reference point. The ordering of the list is bottom-up, with the flights that will 194 

reach the reference point the soonest on the bottom of the list. 195 

To change the format: 196 

 197 

 198 

2.1.2.6 Duration 199 

By default, the duration of the Timeline is set to display from 3 minutes into the past to 200 

50 minutes into the future for a total of 53 minutes. However, the duration of the 201 

Timeline display can be configured to any interval of the user’s choice.  202 

Step 1: Click on the "Right Data:" drop-down list arrow (Figure 12).  

Step 2: Select an item from the drop-down list for what type of data to display 
on the right side of the Timeline. 

Step 3: Click the “Ok” button. 

 

Figure 12. Timeline data. 

Step 1: Choose either the "Timeline" or the "List" radio button on the left side 

of the Timeline Settings window (Figure 13). 

Step 2: Click the “Ok” button. 

 

Figure 13. Timeline format. 



 

ATD2_1029_v1_STBO_Client_Obs_UM last updated 15 Sep 2017 page 15 of 80 

To change the duration of the Timeline: 203 

 204 

 205 

2.1.2.7 Color Scheme 206 

Timeline datablock colors can be coded by six categories: arrivals/departures, departure 207 

fix, departure gate, departure runway, runway, and weight.  208 

To change the Timeline datablock color scheme: 209 

 210 

 211 

2.1.2.8 Legend 212 

The Timeline legend allows for control of which types of aircraft are displayed on the 213 

Timeline. The legend on the Timeline is interactive. The legend is based on the 214 

Timeline’s organization of flights by the selected color scheme (see section 2.1.2.7). 215 

When the legend is displayed, the title of the legend on the Timeline is the option 216 

Step 1: Choose the starting point for the Timeline. Use either the + and – 
buttons next to the “Start (0 or past minutes):” text box or manually enter a 
number of minutes into the text box (Figure 14). 

Step 2: Choose the ending point for the Timeline. Use either the + and – 
buttons next to the “End:” text box or manually enter a number of minutes 
into the text box. 

Step 3: Click the “Ok” button. The amount of time displayed on the Timeline 

will change from the default duration to whatever duration matches the new 

entry. Additional adjustments can be made to the viewed Timeline duration 

(see section 2.1.3). 

 

Figure 14. Timeline duration. 

Step 1: Click on the "Color:" drop-down list arrow (Figure 15).  

Step 2: Select an item from the drop-down list on which to base the Timeline 
color coding.  

Step 3: Click the “Ok” button. 

 

Figure 15. Timeline color scheme. 
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selected for the color scheme. For the purpose of the following sections, “Departure Fix” 217 

is selected for the Timeline color scheme. 218 

2.1.2.8.1 Show/Hide the Legend 219 

To show/hide the legend: 220 

 221 

 222 

 223 

 224 

Step 1: Select the "Show Legend" checkbox to show the legend (Figure 16) or 
deselect the “Show Legend” checkbox to hide the legend.  

 

Figure 16. Show/hide the Timeline legend. 

Step 2: Click the “Ok” button. The legend will display at the bottom of the 
Timeline (Figure 17). 

 

Figure 17. Deselcting items on the Timeline legend. 
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2.1.2.8.2 Interacting with the Legend 225 

The items in the legend will be displayed in the same color scheme as they are displayed 226 

on the Timeline (Figure 17). For example, the “KRITR” label is displayed in orange, like 227 

the KRITR Timeline datablocks, while the “JOJJO” label is displayed in white, like 228 

JOJJO Timeline datablocks.  229 

Deselecting checkboxes in the legend will turn the item deselected a dark grey color on 230 

the Timeline. Selecting checkboxes in the legend will return the selected item to its 231 

original coloring, as determined by the coloring selected in the Timeline Settings window 232 

(see section 2.1.2.7). 233 

The “All” item at the end of the legend list is deselected whenever any other item in the 234 

legend is deselected. If the “All” checkbox is clicked on as the method to deselect the 235 

“All” item, no other legend items are impacted. When the “All” checkbox is selected, all 236 

other items in the legend are also selected. 237 

2.1.2.9 Timeline Datablocks 238 

In the Timeline Settings window, changes can be made to the configuration of the 239 

Timeline datablocks as well as to the content of the Timeline datablocks. These Timeline 240 

datablock settings options are described in the following sections. 241 

2.1.2.9.1 Timeline Datablock Configuration 242 

Changes to the Timeline datablock configuration can be made to restrict the content of a 243 

single datablock to one line on the Timeline vs. allowing the content of a single datablock 244 

to be written across two lines on the Timeline.  245 

To change the configuration of Timeline datablocks: 246 

 247 

Step 1: Select the "One-Line DB" (datablock) checkbox to restrict the content 
of each datablock to one line (Figure 18) or deselect the “One-Line DB” 
checkbox allow the content of each datablock to be written on two lines 
(Figure 18).  

Step 2: Click the “Ok” button. 
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 248 

Note that currently the only available option for the “Extended Datablock Layout:” 249 

feature in the Timeline Settings window is “Default”. 250 

2.1.2.9.2 Timeline Datablock Content 251 

Content of Timeline datablocks can be adjusted for arrival and departure datablocks 252 

independently. 253 

To change the content of Timeline datablocks: 254 

 255 

 

Figure 18. Timeline datablock configuration. 

Step 1: Select the items to be displayed in the Timeline datablocks (Figure 
19) and deselect items to be removed from the Timeline datablocks. Make 
changes separately for arrivals and departures. 

Step 2: Click the “Ok” button. 
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 256 

Datablock 

Content Item 

Description Content 

available for 

arrivals, 

departures, 

or both 

Flight ID Displays the flight ID/callsign. Both 

Aircraft Type Displays the aircraft type. Both 

Heavy 

Indicator 

Displays an orange H on the datablock to indicate 

that the aircraft is a heavy type. 

Both 

Tail Displays the tail number of the aircraft. Both 

Beacon Code Displays the flight’s beacon code. Both 

Origin Displays the arrival flight’s origin airport. Arrival 

Destination Displays the departure flight’s destination airport. Departure 

Arrival Fix Displays the assigned arrival fix for the arrival flight. Arrival 

Departure Fix Displays the assigned departure fix for the departure 

flight. 

Departure 

Runway Displays the flight’s assigned runway.  

For arrivals, a “^” symbol will appear in front of the 

runway when the runway assignment is populated 

from the Terminal RADAR Approach Control 

(TRACON) scratchpad entries. 

Both 

 

Figure 19. Timeline datablock content. 
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Runway 

OpNec 

Displays a light green “OpNec” when the departure 

flight has been assigned to a runway for operational 

necessity. 

Departure 

Spot Displays the assigned spot for the flight to enter or 

leave the Ramp. 

Both 

Parking Gate Displays the assigned gate for the flight. When the 

flight’s gate is unknown, “UNK” is displayed. 

Both 

Gate Conflict When the flight has a gate conflict, the parking gate 

will display as magenta. 

Both 

APREQ Displays information for flights that have APREQ 

restrictions, including: 

 symbol to indicate the availability of 

electronic negotiations  

 “APREQ” before flights have a negotiated 

release time 

 a release time once one is negotiated 

 symbology during the negotiation process 

(see section 3). 

Departure 

MIT (Miles-In-

Trail) 

Displays an MIT restriction for a flight. Departure 

EDCT Displays the EDCT release time for flights with an 

EDCT restriction.  

Departure 

Ground Stop Displays “GS” for flights with a ground stop. Departure 

Spot Sequence For departures exiting the Ramp at a certain spot, the 

fight’s sequence number to the spot is displayed. So 

if the flight is currently 3rd in line to exit at the spot, a 

“3” will be displayed. This will update as aircraft 

cross into the AMA. Once an aircraft enters the 

AMA, it will no longer be assigned or display a spot 

sequence number. 

Departure 

Altitude Displays the aircraft’s altitude in units of feet / 100. Both 

Speed Displays the aircraft’s speed in nautical miles (nmi). Both 

Taxi Time For arrivals, taxi time displays once the arrival lands 

and has an Actual ON time. Taxi time displays for 

arrivals as follows: 

 Arrival not yet landed: no value 

 Arrival landed but not in the gate: elapsed 

time from Actual ON to "now" 

Both 
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 Arrival in the gate: elapsed time from Actual 

ON to Actual IN 

For departures, taxi time displays as follows: 

 Departure still in the Ramp:  no value 

 Departure in the AMA:  elapsed time from 

Actual SPOT to "now" 

Departure taken off:  elapsed time from Actual SPOT 

to Actual IN 

 257 

 258 

2.1.3 Dragging the Timeline Up or Down 259 

The Timeline can also be dragged up and down by left or right-clicking in the center 260 

column of the Timeline and dragging the mouse up or down (Figure 21). The mouse’s 261 

scroll wheel can also be used as a button to click and drag the Timeline. When the 262 

Timeline is dragged, the duration remains constant, but the start and end times will differ. 263 

For example, if the Timeline is displaying 53 minutes of time from 3 minutes in the past 264 

to 50 minutes into the future, by clicking and dragging the Timeline up 20 minutes, the 265 

Timeline will keep displaying the 53-minute duration, but the start and end time for the 266 

Timeline display will now be from 23 minutes into the past to 30 minutes into the future. 267 

 

Figure 20. Timeline datablocks with all of the Timeline datablock options selected. 
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 268 

Once the Timeline has been dragged, the option to reset the Timeline to the default time 269 

interval will appear in the Timeline’s right-click menu. The default time interval is the 270 

“Duration” in the Timeline Settings panel (see section 2.1.2.6). For example, once the 271 

Timeline has been dragged to display from 23 minutes into the past to 30 minutes into the 272 

future, the Timeline can be reset to display from 3 minutes into the past to 50 minutes 273 

into the future. 274 

To reset the Timeline interval: 275 

 276 

 

Figure 21. Dragging the Timeline up and down. 

Step 1: Right-click on the background of the Timeline. 

Step 2: Select “Reset interval” (Figure 22). The Timeline now displays the 
default time interval. 
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 277 

2.2 Map 278 

The STBO Client Map (Figure 23) is set up to display the layout of the AMA and Ramp 279 

of the airport, as well as flight positions and datablocks. The Map window consists of an 280 

aerial view of the airport surface, flight positions on the surface, drop-down menus (File, 281 

View, Help), and Map configuration toolbar. Flight positions are collected from surface 282 

surveillance.   283 

 284 

 

Figure 22. Right-click on the background of the Timeline to reset the Timeline interval. 

 

Figure 23. STBO Client Map. 
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Like on the Timeline, the default color scheme display for departure flights is green and 285 

for arrival flights is light grey (see section 2.2.4.1.1 and 2.2.4.1.2 for alternative 286 

datablock and color scheme options). Gate conflicts appear as magenta parking gates 287 

when extended datablocks are displayed on the Map.  288 

To create additional Maps: 289 

 290 

The new Map will appear with default departure and arrival datablocks, zoom level, and 291 

location.  292 

2.2.1 Map Aerial View 293 

The aerial view is pre-set to show the layout of the airport, south facing up. Departure 294 

flights are displayed in green and arrival flights in grey. Gate conflicts appear as magenta 295 

parking gates. Flights with long on board are marked on the Map. Flight datablocks also 296 

provide additional information, such as TMI information. 297 

The position of the flights comes from radar data. 298 

2.2.1.1 Tarmac Rule / Long On Board 299 

The Map also displays Tarmac Rule / Long On Board (LOB) information for flights. 300 

LOB is displayed on the Map using a colored disc that surrounds the aircraft icon (Figure 301 

24). LOB timer starts from the flight’s pushback from the gate (Actual Off-Block Time; 302 

AOBT) for departure flights or from the moment wheels touch down (Actual Landing 303 

Time; ALDT) for arrival flights. The following table describes the parameters for when 304 

each LOB disc color is displayed.  305 

 306 

Disc Color LOB Timer 

Step 1: Click on “Create” on the STBO Client Toolbar. 

Step 2: Select “Create Map”. 

 

Figure 24. Map Long On Board. 
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Yellow 60-89 minutes 

Orange 90-119 minutes 

Red 120+ minutes 

 307 

2.2.2 Menus  308 

Two menus are available on the top left of the Map: File and View.  309 

The “File” menu (Figure 25) provides the ability to shut down the STBO Client. To shut 310 

down the STBO Client:  311 

 312 

 313 

The “View” menu (Figure 26) provides visual options: to show, or hide, the Map toolbar 314 

(section 2.2.2.1), aircraft at the gates (section 2.2.2.2), flights by line of flight (section 315 

2.2.2.3), or clear highlighted flights (section 2.2.2.4). 316 

 317 

Step 1: Click on the “File” menu in the Map window. 

Step 2: Click on “Shutdown STBO.”  

Step 3: Confirm STBO Shutdown. Clicking “Yes” will shut down the whole 

STBO Client program. 

 

Figure 25. Map “File” drop-down menu. 

 

Figure 26. Map “View” drop-down menu. 
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2.2.2.1 Toolbar 318 

To show the STBO Client Toolbar (see section 2.4): 319 

 320 

2.2.2.2 Aircraft at Gates 321 

The “Aircraft at Gates” function impacts all open Maps on the STBO Client interface. If 322 

this function is enabled on one Map, it’s automatically enabled on all Maps. When this 323 

function is enabled, it shows the physical aircraft at the gates with their tail numbers. 324 

To show/hide aircraft at the gates: 325 

 326 

2.2.2.3 Flights by Line of Flight 327 

The STBO Client displays information for all flights in the system for the day, even if 328 

multiple flights are using the same physical aircraft. “Line of Flight” refers to which 329 

flight is using a physical aircraft. For example, flight A (an arrival) and flight B (the 330 

turnaround departure for the arrival) can share a physical aircraft. If the “Flights by Line 331 

of Flight” checkbox is checked, only the current flight is displayed. If the “Flights by 332 

Line of Flight” checkbox is unchecked, both flight A and flight B are displayed, even 333 

though they occupy the same physical aircraft. 334 

This checkbox also affects “expired” flights. The STBO Client has a timeout parameter; 335 

an arrival will display for N minutes after it arrives at the gate and receives an IN time. 336 

Values for N are listed in the table below. Once the timeout value is reached (N minutes 337 

after the IN time), the flight becomes “expired.” Expired flights are not displayed when 338 

the “Flights by Line of Flight” checkbox is checked. If the “Flights by Line of Flight” 339 

checkbox is unchecked, the flight continues to be displayed until it is deleted from the 340 

system. This N value is not configurable. 341 

N value for 

“Flights by 

Line of Flight” 

Description of when to use each N value 

10 minutes Used for any arrival flights that will turnaround as departures. 

30 minutes Used for domestic arrival flights with no turnaround departures. 

75 minutes Used for international arrival flights with no turnaround departures. 

 342 

Step 1: Click on the “View” menu in the Map window. 

Step 2: Select on “Show Toolbar.” This will bring the STBO Client Toolbar 

to the forefront of the STBO Client windows. 

Step 1: Click on the “View” menu in the Map window. 

Step 2: Select the “Aircraft at Gates” checkbox to display all untracked 

aircraft parked at the gates and their tail numbers or deselect the “Aircraft at 

Gates” checkbox to hide all untracked aircraft parked at the gates and their 

tail numbers. 
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To show/hide flights by line of flight: 343 

 344 

2.2.2.4 Clear Highlighting of Flights on the Map 345 

There are two methods for clearing out the highlighting/selecting of flights on the STBO 346 

Client Map.  The first is to click anywhere else on the Map background, and the second is 347 

to use the “View” menu in the Map window. 348 

To clear all highlighted flights on the Map: 349 

 350 

2.2.3 Help Menu and Quick Keys 351 

On the top right of the Map is the help menu (Figure 27). This menu provides access to 352 

the software version (About), or the quick keys for the Flights Table (Flights Table Help), 353 

Map (Map Help), or Timeline (Timeline Help).  354 

 355 

To find out about the software version currently in use: 356 

 357 

Step 1: Click on the “View” menu in the Map window. 

Step 2: Select the “Flights by Line of Flight” checkbox to hide expired flights 

or deselect the “Flights by Line of Flight” checkbox to show expired flights. 

Step 1: Click on the “View” menu in the Map window. 

Step 2: Click on “Clear Highlighted Flights.” This will unselect all flights that 

are highlighted. 

 

Figure 27. Map “Help” drop-down menu. 

Step 1: Click on the “Help” menu in the Map window. 

Step 2: Click on “About.” A window appears with the version number and the 

build (Figure 28).  

Step 3: Click on “OK” to close the window. 
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 358 

Some users prefer to use quick key functions to navigate through the interface and 359 

interact with it. Quick key functions exist in the system today for the Flights Table, Map 360 

and Timeline. The Map “Help” menu can be used to view lists of these quick key 361 

functions. 362 

To open the list of quick keys for the Flights Table: 363 

 364 

 365 

To open the list of quick keys for the Map: 366 

 367 

 368 

 369 

 

Figure 28. STBO Client version information. 

Step 1: Click on the “Help” menu in the Map window. 

Step 2: Click on “Flights Table Help.” A window appears with a list of 

keyboard and mouse shortcuts for various Map functions (Figure 29).  

Step 3: Click on “Close” to close the window. 

 

Figure 29. Flights Table Help window. 

Step 1: Click on the “Help” menu in the Map window. 

Step 2: Click on “Map Help.” A window appears with a list of keyboard and 

mouse shortcuts for various Map functions (Figure 30).  

Step 3: Click on “Close” to close the window. 
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370 
To open the list of quick keys for the Timeline: 371 

 372 

 

Figure 30. Map Help window. 

Step 1: Click on the “Help” menu in the Map window. 

Step 2: Click on “Timeline Help.” A window appears with a list of keyboard 

and mouse shortcuts for various Map functions (Figure 31).  

Step 3: Click on “Close” to close the window. 
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 373 

2.2.4 Map Toolbar 374 

There are several functions available to the user on the Map toolbar (Figure 32). The Map 375 

Toolbar has a tooltip feature (Figure 33) that displays the labels for button functions 376 

when hovering over each button. The tooltip displays for 5 seconds. 377 

 378 

 

Figure 31. Timeline Help window. 

 

Figure 32. Map toolbar. 
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 379 

The following table provides a description of the Map toolbar buttons from left to right. 380 

For those Map toolbar buttons that open windows to provide additional functionality, a 381 

more in-depth description of the windows is provided in sections 0-4. 382 

Map Toolbar Button Description 

Setup Datablocks Opens a settings window for making adjustments to how all 

Map datablocks are displayed 

Toggle Arrival 

Datablocks 

Toggle between “No DB”, “ACID (Aircraft ID/callsign) only 

DB”, and “Extended DB” for arrival flights 

Toggle Departure 

Datablocks 

Toggle between “No DB”, “ACID only DB”, and “Extended 

DB” for departure flights 

Zoom In Zoom in on the Map 

Zoom Out Zoom out on the Map 

Reset Zoom Return to the default Map zoom level 

Setup Range Rings Opens settings window to set interval for range ring spacing, 

show range rings, show distance labels for each range ring, 

and set the max distance to show range rings 

Rotate Map Select one of four orientations for the Map (0°, 90°, 180°, 

270°). 

Note: Choosing the orientation the Map is currently on will 

result in no rotation. 

Setup 

Arrival/Departure 

Fixes and Airports 

Add specific fixes and airports to the display, overlay 

TRACON map onto airport map 

Setup Map Opens a window to change settings for showing or hiding 

labels, shapes, and other items on the Map 

 383 

2.2.4.1 Setup Datablocks  384 

The Setup Datablocks button on the Map toolbar opens the Setup Datablocks window 385 

(Figure 34), which enables changing the Map datablock configurations, color schemes, 386 

 

Figure 33. Tooltips on the Map toolbar. 
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displaying the legend, showing (untracked) flights at the gate, editing Map datablock 387 

content, and other display filters. These Map datablock setting features are described in 388 

the following sections. 389 

 390 

2.2.4.1.1 Map Datablock Configuration 391 

Map datablocks can be configured separately for arrivals and departures. Datablocks can 392 

be configured to display as no datablocks, ID (aircraft callsign) only datablocks, or 393 

extended datablocks (Figure 35). The following example will use the arrival datablocks 394 

to demonstrate the steps for changing the datablock displays. 395 

To change the flight datablock display using the Setup Datablock window: 396 

 397 

 398 

 

Figure 34. Setup Datablocks window for the STBO Client Map. 

Step 1: Click on the "Arrival" drop-down menu next to “Flight Datablock 
Display:” (Figure 35).  

Step 2: Select the desired option for displaying the flight datablock. 

Step 3: Click the “Ok” button. 
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 399 

The “Extended Datablock Config:” feature enables the changing of the standard color for 400 

the Map datablock backgrounds between “Default” and “ramp”. This feature is only 401 

applicable when using extended datablocks and does not impact the aircraft icon on the 402 

Map, only the flight’s datablock backround. Aircraft icons will match the Map datablock 403 

color scheme, described in section 2.2.4.1.2. The following table describes the 404 

differences for these two options: 405 

Extended Datablock Config: 

Options 

Descrition of Datablock Background Changes 

Default All: No background color 

Datablock text: matches the color scheme selected 

as described in section 2.2.4.1.2 

ramp Arrivals: green 

Departures: blue for eastbound flights, brown for 

westbound flights 

All datablock text: white 

 406 

2.2.4.1.2 Color Scheme 407 

Map datablock colors can be organized by six categories: arrivals/departures, departure 408 

fix, departure gate, departure runway, runway, and weight. The color of the Map aircraft 409 

icons matches datablocks for the color scheme as well. 410 

To change the Map datablock color scheme: 411 

 412 

 

Figure 35. Flight Datablock Display. 

Step 1: Click on the "Color:" drop-down list arrow (Figure 36).  

Step 2: Select an item from the drop-down list on which to base the Timeline 
color coding.  

Step 3: Click the “Ok” button. 
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 413 

2.2.4.1.3 Legend 414 

The Map legend provides information about categories of aircraft that are displayed on 415 

the Map. The legend on the Map is not interactive. The legend is based on the Map’s 416 

organization of flights by the selected color scheme (see section 2.1.2.7). When the 417 

legend is displayed, the title of the legend is displayed as the option selected as the color 418 

scheme. For the purpose of this section, “Departure Fix” is selected for the Map color 419 

scheme.  420 

To show/hide the legend: 421 

 422 

 423 

 424 

 

Figure 36. Map color scheme. 

Step 1: Select the "Show Legend" checkbox to show the legend or deselect 
the “Show Legend” checkbox to hide the legend (Figure 37).  

Step 2: Click the “Ok” button. The legend will display on the right side of the 
Map (Figure 38). 

 

Figure 37. Show/hide the Map legend. 
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 425 

Unlike the Timeline legend, the Map legend is not interactive; there are no check boxes 426 

to select or unselect items from the legend. 427 

2.2.4.1.4 Flights at Gates 428 

The “Flights at Gates” function only applies to the current selected Map. When this 429 

function is enabled, it shows the flights at the gates with their callsigns / flight numbers. 430 

To show/hide flights at gates: 431 

 432 

2.2.4.1.5 Suspended Flights 433 

To show/hide suspended flights: 434 

 435 

 

Figure 38. Map legend. 

Step 1: Select the “Show Flights at Gates” checkbox to display all untracked 

flights parked at the gates and their flight numbers or deselect the “Show 

Flights at Gates” checkbox to hide all untracked flights parked at the gates 

and their flight numbers. 

Step 2: Click the “Ok” button. 

Step 1: Select the “Show Suspended Flights” checkbox to display all 

suspended flights or deselect the “Show Suspended Flights” checkbox to hide 

all suspended flights. 

Step 2: Click the “Ok” button. 
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2.2.4.1.6 Declutter Tags 436 

By default, the “Declutter Tags” function is not enabled. The Map normally allows flight 437 

datablocks to overlap as the aircraft traverse the surface of the airport. When the 438 

“Declutter Tags” function is turned on, flight datablocks on the Map will move around 439 

the flights so that the flight datablocks do not overlap. 440 

To show/hide flights at gates: 441 

 442 

Flight datablocks can also be repositioned on the Map by clicking and dragging the 443 

datablock to a new position directly on the Map. 444 

2.2.4.1.7 Map Datablock Content 445 

Content of Map datablocks can be adjusted for arrival and departure datablocks 446 

independently. These controls are only available if “Extended DB” has been selected (see 447 

section 2.2.4.1.1).  448 

To change the content of Map datablocks: 449 

 450 

 451 

Step 1: Select the “Show Flights at Gates” checkbox to display all untracked 

flights parked at the gates or deselect the “Show Flights at Gates” checkbox 

to hide all untracked flights parked at the gates (Figure 37). 

Step 2: Click the “Ok” button. 

Step 1: Select the items to be displayed in the Map datablocks (Figure 39) and 
deselect items to be removed from the Map datablocks. Make changes 
separately for arrivals and departures. 

Step 2: Click the “Ok” button. 

 

Figure 39. Map datablock content. 
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2.2.4.2 Setup Range Rings 452 

Range rings are a valuable tool in helping to judge distance on the STBO Client Map. 453 

The Setup Range Rings window provides a means to make changes to the way range 454 

rings are displayed. 455 

To setup Range Rings (Figure 40): 456 

 457 

 458 

2.2.4.3 Setup Arrival and Departure Fixes, and Airport and Airspace Elements 459 

The Setup Arr/Dep Fixes and Airports window provides the ability to display arrival and 460 

departure fixes, as well as other airports and video-maps of the TRACON (Figure 41). 461 

The following sections describe how to use the Setup Arr/Dep Fixes and Airports 462 

window. 463 

2.2.4.3.1 Arrival Fixes 464 

When the Setup Arr/Dep Fixes and Airports window is opened, the default tab is the 465 

“Arrival Fix” tab. 466 

Step 1: Click on the Range Ring button to set interval for range ring spacing.  

Step 2: Select the “Show Range Rings” checkbox to show range rings. 

Step 3 (optional): Select the “Show Range Distance Labels” checkbox to 

display the value of each range ring.  

Step 4 (optional): Click on the colored box to select the color of the range 

rings. This will open the Choose Color window. For more information on 

how to interact with the Choose Color window, see section 2.2.4.4. 

Step 5: Enter the value of the maximum distance in nmi to show range rings 

in the box next to “Total Distance from Airport to Display Range Rings:” 

Step 6: Enter the value of the distance between the range ring in nmi in the 

box next to “Distance Between Range Rings:”.  

Step 7: Click on the “OK” button. 

 

Figure 40. Setup Range Rings window. 
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To configure the arrival fix displays on the Map (Figure 41): 467 

 468 

 469 

2.2.4.3.2 Departure Fixes 470 

To configure the departure fix displays on the Map (Figure 42): 471 

 472 

Step 1: Select the “Show Arrival Fixes” checkbox to display the arrival fixes.  

Step 2 (optional): Enter a value for the spacing between the distance markers 

for the arrival procedures in nmi.  

Step 3 (optional): Enter the total number of distance markers to display inside 

the arrival fix (or rather, between the arrival fix and your airport). Note: enter 

“0” (zero) if no spacing markers are desired. 

Step 4 (optional): Enter the total number of distance markers to display 

outside the arrival fix, away from your airport. Note: enter “0” (zero) if no 

spacing markers are desired. 

Step 5: Click on the “OK” button. The arrival fixes and procedures will now 

display in blue on the Map. 

 

Figure 41. Setup Arrival Fixes. 

Step 1: Click on the “Departure Fix” tab. 

Step 2: Select the “Show Departure Fixes” checkbox to display the departure 

fixes.  

Step 3: Click on the “OK” button. The departure fixes will now display in 

cyan on the Map. 
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 473 

2.2.4.3.3 Airports 474 

To configure the airport displays on the Map (Figure 43): 475 

 476 

 

Figure 42. Setup Departure Fixes. 

Step 1: Click on the “Airports” tab. 

Step 2: Select the “Show Airports” checkbox. 

Step 3: Click on the “Add Airport” button on the right side of the window. 

This will open the “Airport Input” window. 

Step 4: Select the checkbox next to the desired airports or type the 3-letter 

airport code into the text box (e.g., “RDU”). 

Step 5: Click on the “OK” button. If the airport code was typed incorrectly, an 

error message will appear. If the airport code was entered correctly, the 

airport now appears in the list on the “Airports” tab. 

Step 6: Click on the “OK” button. The listed airports will now display in 

yellow text on the Map. 
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 477 

2.2.4.3.4 TRACON Maps 478 

To configure the airport displays on the Map (Figure 44): 479 

 480 

 

Figure 43. Airports window. 

Step 1: Click on the “TRACON Maps” tab. 

Step 2: Select the “Show Selected TRACON Map” checkbox. 

Step 3: Click on the drop-down menu. 

Step 4: Select a TRACON map to overlay onto the Map window. Only one 

map can be selected. 

Step 5 (optional): Click on the “Choose Map Color (applies to all maps)” 

button. This opens the Choose TRACON Map Color window 

Step 6 (optional): Select a color from one of the tabs. This color will be 

applied to any map selected from the TRACON map drop-down list. (For 

more information on how to interact with the Choose Color window, see 

section 2.2.4.4.) 

Step 7: Click on the “OK” button. The TRACON map will now display in the 

selected color on the Map. 
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 481 

2.2.4.4 Set up Map and Colors 482 

The “Setup Map” button on the Map toolbar opens the Setup Map window, which 483 
enables changing the labels, shapes, and other items on the Map (e.g., selecting the 484 
“ADW” checkbox displays the physical boundary for the Arrival/Departure Window 485 
(ADW) on the Map; Figure 45). The left column on the window (“Layer”) lists the 486 
different layer items that can be displayed on the Map. Selection of checkboxes from the 487 
middle column (“Display”) will populate the layer item on the Map. The right column 488 
(“Color”) allows for the selection of what color the Map uses to display each of the layer 489 
items. 490 

 

Figure 44. TRACON Maps. 
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 491 

To choose items to display on the Map and select colors for displaying each item: 492 

 493 

 494 

 

Figure 45. Setup Map window. 

Step 1: Locate the item to be displayed from the “Layer”. Select the 
corresponding checkbox for that item under the “Display” column. 

Step 2 (optional): Click on the colored square for that item under the “Color” 
column to change the color for displaying the layer item. A single click will 
open the Choose Color window. 

Step 3: On the “Swatches” tab, click on the desired colored squared. The 
color is now displayed at the bottom of the tab in the “Preview” section. Note 
that once a color is selected, the other tabs will provide information for that 
color and allow for refining the color selection (additional description on 
these other tabs is provided below). 

Step 4: Click the “OK” button to close the Choose Color window. The 
colored square in the “Color” column has now changed to the selected color. 

Step 5: Click the “Ok” button to apply the change and close the Color settings 
window. The layer item now appears on the Map. 
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 495 

The other tabs on the Choose Color window are: Hue-Saturation-Value (HSV), Hue- 496 
Saturation-Lightness (HSL), Red-Green-Blue (RGB), and Cyan-Magenta-Yellow-Key 497 
(CMYK; “Key” is black). An example of the RGB tab is shown in Figure 47. In these 498 
windows, a color can be changed by dragging the various parameters, such as hue, 499 
saturation, lightness, or any of the main colors (blue, green, red, cyan, magenta, and 500 
yellow). A color can also be changed by clicking on a desired color inside the vertical 501 
gradient of colors and inside the axial gradient square.  502 

 503 

 

Figure 46. Flights Table Color Settings – choose a color. 

 

Figure 47. Flights Table Color Settings – choose an RGB value. 
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2.3 Flights Table 504 

The Flights Table (Figure 48) provides a list of flights for the airport. Each flight selected 505 

in the table is highlighted in the Flights Table, on the Map, and on the Timeline. 506 

 507 

2.3.1 Creating a New Flights Table 508 

There are a few different types of tables that can be created in the STBO Client: Flights 509 
Table, Aircraft Table, and Departure Fix Status Table. Multiple Flights Tables can be 510 
created at one time to display and help organize different data. Only one Aircraft Table 511 
and one Departure Fix Status Table can be created at a time. 512 

To create a new table: 513 

 514 

 515 
To add or remove fields in the new table, see the Set Column function described below in 516 

the Flights Table Toolbar section 2.3.3. 517 

2.3.2 Sorting Data 518 

The data in the Flights Table can be sorted by selecting any header. For instance, 519 
selecting “Dest” will sort all flights alphabetically by destination airport.  520 

 

Figure 48. STBO Client Flights Table. 

Step 1: Click on “Create” on the STBO Client Toolbar. 

Step 2: Click on “Create Table.” 

Step 3: Select “Flights Table” A new generic Flights Table will appear 

(Figure 49). 

 

Figure 49. Create a new Flights Table. 
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To sort the data: 521 

 522 

2.3.3 Flights Table Toolbar 523 

The Flights Table toolbar is located on the top left of the Flights Table. This toolbar 524 
provides the following functions for altering and interacting with the Flights Table 525 
(Figure 50):  526 

 Close the Flights Table 527 

 Filter data 528 

 Set columns (data fields) 529 

 Set colors in the Flights Table 530 

 Search  531 

532 
The following sub-sections describe the various Flights Table toolbar features and how to 533 
use them. 534 

2.3.3.1 Filter Function 535 

The filter function down selects the data displayed to specified criteria.  536 

To filter data: 537 

 538 

Step 1: Click on any header. This will list the flights from the lowest to the 

highest value. 

Step 2: Click on the same header. This will list the flights from the highest 

value to the lowest value. 

Step 3: Click on the same header to cancel the sorting feature.  

 

Figure 50. Flights Table toolbar elements. 

Step 1: Click on the funnel icon. A Search window appears with selectable 

fields (Figure 51). 



 

ATD2_1029_v1_STBO_Client_Obs_UM last updated 15 Sep 2017 page 46 of 80 

  539 

 540 

 541 

 542 

 

Figure 51. Filter window for the Flights Table. 

Step 2: Select the desired data field by clicking on the “- - Select - -” drop-

down button (Figure 52).  

 

Figure 52. Select a field to filter by. 

Step 3: Once the field is selected, select the operator by clicking on the “=” 

drop-down button. Up to 5 options for the operator are possible for a single 

“Field”, depending on the “Field” selected (7 total possible operators; Figure 

53): 

 equal “=” 

 not equal “!=” 

 less than “<” 

 less than or equal to “<=” 

 greater than “>” 

 greater than or equal to “>=” 

 or “BETWEEN” 
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 543 

 544 

 545 

 546 

 

Figure 53. Select an operator to filter by. 

Step 4: Next to the Operator, type in or select a value from the drop-down list 

(Figure 54). The Figure shows a drop-down list of all departure fixes for 

Charlotte Douglas International Airport (CLT).   

Note that multiple items can be selected and/or added to the list in the 

“Value” text box. When desiring to add multiple values for the same “Field” 

under the same condition (“AND” vs. “OR”), enter all values in the same 

“Value” text box. STBO Client cannot process multiple lines of the same 

condition and the same field. 

For example, “Dep Fix = BARMY,KILNS” and “Dep Fix = BARMY OR 

Dep Fix = KILNS” are okay, but “Dep Fix = BARMY AND Dep Fix = 

KILNS” will not work.  

 

Figure 54. Select a value to filter by. 

Step 5: If another criterion is needed, repeat Step 2 by clicking on the Field 
drop-down list in the next row. The logical argument to the left of the Field 
drop-down list can be changed to “OR” via its drop-down list, if desired.  

In the example in Figure 55, the destination field was added to filter flights to 

BARMY departure fix and to LaGuardia International Airport (LGA).  
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 547 

 548 

 549 
To remove the filter: 550 

 551 

 552 

2.3.3.2 Setup of Columns in Flights Table 553 

The fields, and their order can be swapped out and moved around in the Column Settings 554 
window.  555 

To access the Column setting: 556 

 557 

The window displays two lists (Figure 57). The one on the left shows fields that are 558 
available, but not displayed on the Flights Table. The one on the right are the fields that 559 
are currently displayed in the Flights Table.  560 

 

Figure 55. Enter values to filter by. 

Step 6: Click “OK” to close the window. The Flights Table now only displays 
the flights that match the selected criteria. 

In the example, the Flights Table only shows flights that are going to LGA 
via the BARMY departure. 

Step 1: Click on the button with the funnel image. 

Step 2: Click on “Clear” on the far right, next to each field argument. 

Step 3: Click on “OK”. 

Step 4: Confirm that the search field has no value (Figure 56). 

Step 5: Click “OK” to close the window. 

 

Figure 56. Cleared the filters from the Flights Table. 

Step 1: Click on the Set Columns in Flights Table button (the third button). 
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 561 

To move a field up or down on the list and reorder the way fields are displayed in the 562 
Flights Table: 563 

 564 

 565 

 

Figure 57. Column Settings window for Flights Table. 

Step 1: Inside of the Column Settings window, select the field in the right 

“Shown” list. 

Step 2: Click on either “Move Up” or “Move Down” (Figure 58). A higher 

position in the “Shown” list results in moving that field to the left in the 

Flights Table. 

 

Figure 58. Moving column positions in the Column Settings window. 
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To add a field to the Flights Table: 566 

 567 

 568 

  569 

Step 1: Select the field in the “Available” list to be added to the “Shown” list 
(list of items displayed in the Flights Table). 

Step 2: Select the field on the “Shown” list where the added field should be 
inserted (Figure 59). 

 

Figure 59. Add a column to the Flights Table – select a field. 

Step 3: Click on the right arrow “>” in the middle of the lists. The new field 
should now be inserted above the selected field in the “Shown” list (Figure 
60).  

Step 4: Click “Ok” to close the window. 
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 570 

To remove a field from the Flights Table: 571 

 572 

2.3.3.3 Color Settings 573 

The color setting provides additional enhancements to the Flights Table for readability. 574 
Some fields are already preset with colors to alert the user of specific events.  575 

To access the color settings: 576 

 577 

2.3.3.3.1 Set Row Colors 578 

The “Set Row Colors” tab gives options to set different colors for the rows of the Flights 579 
Table. The row colors can be set to alternate for even and odd rows.  580 

 

Figure 60. Add a column to the Flights Table – field added. 

Step 1: Select the field in the “Shown” list to be removed. 

Step 2: Click on the left arrow “<” in the middle of the lists. The field should 
move to the “Available” list on the left. 

Step 3: Click “Ok” to close the window. 

Step 1: Click on the symbol to the left of the search field (Figure 50) to open 
the Flights Table Color Setting window (see Figure 61). 
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To change the colors of the rows: 581 

 582 

 583 

 584 

Step 1: On the “Set Row Colors” tab (Figure 61), click on the colored square 
next to either the “Even Row Color” or “Odd Row Color” option to change 
the color for that set of rows. A single click will open the Choose Row Color 
window. 

Step 2: On the “Swatches” tab (Figure 62), click on the desired colored 
squared. The color is now displayed at the bottom of the tab in the “Preview” 
section. Note that once a color is selected, the other tabs will provide 
information for that color and allow for refining the color selection 
(additional description on these other tabs is provided below). 

Step 3: Click the “OK” button to close the Choose Row Color window. The 
colored square on the “Set Row Colors” tab has now changed to the selected 
color. 

Step 4: Click the “Ok” button to apply the changes and close the Flights Table 
Color Settings window.  

 

Figure 61. Flights Table Color Settings window – Set Row Colors. 

 

Figure 62. Flights Table Color Settings – Swatches. 
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2.3.3.3.2 Set Field Color Alerts 585 

The “Set Field Color Alerts” tab provides options to highlight particular events in the 586 
Flights Table (Figure 63).  587 

 588 

 589 

Flight ID events are already pre-set with colors. Those are flights with gate conflict, 590 
flights that are cancelled, flights with a closed departure fix, and flights with a Ground 591 
Stop. Each color can be changed by clicking on the color sample rectangle. Each instance 592 
of the value specified in the “Set Field Color Alerts” tab will be displayed with the given 593 
color in the Flights Table. The table below lists where each type of color alert is 594 
displayed. Figure 64 provides an example of displaying flight statuses for flights taxiing 595 
in the AMA in a green color. 596 

Field for Color Alerts Column Where the Color Alert is Displayed 

Has Gate Conflict Gate 

Flight Status Flight Status 

Has Closed Departure Fix Dep Fix 

Has Ground Stop Dest 

Is Hidden Flight ID 

 597 

 

Figure 63. Flights Table Color Settings – set color alerts. 
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To change the colors of the Flights Table alerts: 598 

 599 

 600 

2.3.3.4 Search Field 601 

The search field provides the ability to search for flight numbers, callsigns, destination 602 
airports, or departure fixes in the Flights Table. The matching flights will be highlighted 603 
in the Flights Table, and also on the Timeline and on the Map.  604 

To search for information in the Flights Table: 605 

 606 

There is no need to click on the Search button. As information is typed in, STBO Client 607 
searches for any flights that matches the query. For example, typing “FDX” will highlight 608 
all FedEx flights. Typing “LGA” will highlight all flights to LGA (Figure 65). Typing 609 
“53” will highlight all flights whose flight number contains “53”, independent of airline. 610 

Step 1: On the “Set Field Color Alerts” tab, click on the colored square that 
corresponds the desired “Field”. A single click will open the Choose Color 
window. 

Step 2: On the “Swatches” tab, click on the desired colored squared. The 
color is now displayed at the bottom of the tab in the “Preview” section. Note 
that once a color is selected, the other tabs will provide information for that 
color and allow for refining the color selection (additional description on 
these other tabs is provided below). 

Step 3: Click the “OK” button to close the Choose Color window. The 
colored square on the “Set Field Colors Alerts” tab has now changed to the 
selected color. 

Step 4: Click the “Ok” button to apply the changes and close the Flights Table 
Color Settings window.  

 

Figure 64. Color alerts on Flights Table. 

Step 1: Type in any string of letter or number for callsigns.  

or 

Step 1: Type a 3 letter airport code for a destination airport. 

or 

Step 1: Type in a departure fix name in full letters.  
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 611 

2.3.4 Data in the Flights Table 612 

The data displayed in the Flights Table is described in the table below. The “Available” 613 

columns are listed in (mostly) alphabetical order by commonly used items, then in 614 

(mostly) alphabetical order by less commonly used items 615 

Column Header Description 

AC Type International Civil Aviation Organization (ICAO) type of aircraft, 

i.e. B738: Boeing model 737-800 

Actual Time In 

Queue 

Actual TakeOff Time (ATOT) – Undelayed TakeOff Time 

(UTOT).  This field only displays once the flight takes off. 

AIBT Actual In Block Time of the aircraft at the gate recorded by the 

airline or STBO 

ALDT Actual Landing Time of the aircraft recorded by the airline or 

STBO 

Altitude Last recorded altitude in units of feet / 100 

AMA Taxi 

Duration 

Duration of time on the AMA 

 Departures: OFF time – spot time 

 Arrivals: spot time – ON time 

OFF time, ON time, and spot time are the actual time of the flight 

when it uses the runway or crossed the spot; otherwise these 

times are predicted by STBO. 

AMAT  Actual Movement Area entry Time when the departure crossed 

the spot 

AOBT Actual Off Block Time of the aircraft at the gate recorded by the 

airline or STBO 

APREQ Lists either  

 “APRQ” to indicate that the flight needs an APREQ time 

 “APRQ: REQ” to indicate negotiation is in progress 

 The assigned APREQ roll time, e.g. “2330” 

 

Figure 65. Search for LGA flights in the Flights Table. 
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APREQ Forced Indicates whether or not the APREQ time was set using the 

Integrated Departure Arrival Capability (IDAC) negotiation 

process through the STBO Client.  

 FALSE if the APREQ time was negotiated through IDAC 

 TRUE if the APREQ time was manually set by a user or 

was received through System Wide Information 

Management (SWIM) apart from IDAC 

APREQ Mode Lists the modes of handling the APREQ requests in TBFM by the 

Center Traffic Management Coordinator (TMC):  

 UNDETERMINED – Mode has not been set 

 MANUAL - Requests from the Tower needs to be made 

over the phone 

 SEMI - Requests are made via IDAC, but still require 

electronic approval by the Air Route Traffic Control 

Center (ARTCC) TMC 

 AUTO - Requests are made via IDAC and are 

automatically approved by TBFM 

 OFF - TBFM is not being used to schedule APREQ 

release times. Requests must be made by telephone. 

APREQ Change 

Ack Status 

Displays “Needs ACK” when the requested APREQ release time 

sent by the Air Traffic Control Tower (ATCT) through the STBO 

Client is not equal to the scheduled APREQ release time received 

back from the ARTCC TBFM. Equality is determined in minutes. 

APREQ Release 

Req Allowed 

Indicates whether an APREQ release request can be made 

through the STBO Client. Currently, release requests are always 

allowed through the STBO Client for IDAC flights. 

APREQ 

Requested Roll  

Requested APREQ release time, minus 38 seconds to adjust to 

the start of the takeoff roll  

APREQ 

Scheduled Roll  

Scheduled APREQ release time, minus 38 seconds to adjust to 

the start of the takeoff roll 

APREQ 

Scheduled 

Wheels Off 

Scheduled APREQ release time at wheels-up (corresponds to the 

scheduled release time set in TBFM) 

APREQ Source Data source from which the APREQ release time originates 
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APREQ State Indicates the status of the APREQ negotiation: 

 UNSCHEDULED - The APREQ release time has not 

been requested yet 

 PENDING_SCHEDULE – The APREQ release time has 

been requested by ATCT but not accepted yet by ARTCC 

 SCHEDULED – The APREQ release time as scheduled 

by the ARTCC and sent to the ATCT 

 PENDING_ACCEPT – ATCT start of negotiation for 

accepting the ARTCC scheduled release time 

 ACCEPTED - The APREQ request time has been 

accepted by ATCT 

 PENDING_CANCEL – The ATCT has issued a request 

to cancel APREQ negotiation 

 CANCELLED – The APREQ negotiation has been 

cancelled by the ATCT or ARTCC 

Arr Fix Predicted (if aircraft has not yet crossed the fix) or actual (if 

aircraft has crossed the fix) arrival fix / Standard Terminal Arrival 

Route (STAR) the aircraft has or flown or will fly. If the 

originally-assigned fix is closed and an alternate has been 

specified, this will display “<origFix> -> <altFix>”. 

Arr/Dep Lists either: 

 “A” for arrival 

 “D” for departure 

ArrFix Source Indicates the data source to determine the arrival fix: 

 SOURCE – The arrival fix was received from an external 

source based on the flight plan 

 DECISION_TREE – STBO is predicting the arrival fix 

based on the most commonly used arrival fix for flights 

flying between the origin and destination airports 

 MODEL – STBO is predicting the arrival fix to be the one 

closest to straight line between the origin and departure 

airport; or the arrival fix is based on a fix closure and a set 

of alternate fixes 

 SURFACE – The arrival fix was detected based on track 

data 

 UNKNOWN – The arrival fix is unknown. This option 

should only occur for CLT departures. 

ArrFix Time Predicted (if the aircraft has not yet crossed the fix) or actual (if 

the aircraft has crossed the fix) crossing of aircraft at the arrival 

fix 

ATOT Actual TakeOff Time of aircraft recorded by the airline or STBO 

Beacon Code Beacon code of the flight 

Dep Fix Departure fix that aircraft is planned to fly to, or has flown to 
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Dep Gate Departure Gate that aircraft is planned to fly to, or has flown to. If 

departure fix is not mapped to a departure gate, then this column 

contains the departure fix. 

DepFix 

AwaitCDR 

Displays “Awaiting CDR” (Coded Departure Route) if the 

originally-assigned fix for a departure flight is closed and an 

alternate has not yet been specified 

DepFix Source Indicates the data source to determine the arrival fix: 

 SOURCE – The departure fix was received from an 

external source based on the flight plan 

 DECISION_TREE – STBO is predicting the departure fix 

based on the most commonly used departure fix for flights 

flying between the origin and destination airports 

 MODEL – STBO is predicting the departure fix based on 

a fix closure and a set of alternate fixes 

 SURFACE: the departure fix was detected based on track 

data 

 UNKNOWN – the departure fix is unknown. This option 

should only occur for CLT arrivals 

DepFix Time For departures, the actual (if aircraft has crossed the fix) or 

predicted (if aircraft has not yet crossed the fix) time the aircraft 

crossed or flew by the departure fix 

Dest Destination airport of the flight 

EDCT Expect Departure Clearance Time assigned to the flight as part of 

a Ground Delay Program (GDP), Airspace Flow Program (AFP) 

or Collaborative Trajectory Options Program (CTOP) 

EOBT Earliest Off-Block Time provided by the airline. A new surface 

data element providing the best prediction of when a flight will be 

ready to push back. 

EstIBT Estimated In-Block Time provided by an external source other 

than the airline 

EstOBT Estimated Off-Block Time provided by an external source other 

than the airline 

ETA Estimated Time of Arrival provided by TBFM, TFMS, the 

airline, or other external sources 

ETD Estimated Time of Departure at wheels-up provided by TBFM, 

Traffic Flow Management System (TFMS), the airline, or other 

external sources 

Flight ID Callsign of the flight 

Flight Key Unique identifier for the flight that contains the callsign, the 

origin, destination, flight creation time, and flight creation source, 

e.g., Airline, TFM, Traffic Management Advisor (TMA; TBFM) 
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Flight Status Lists the aircraft state and location: 

 Cancelled – The flight has been cancelled by the airline 

 Departed – A departure aircraft is airborne 

 Enroute_Arr – An arrival aircraft is in the enroute airspace 

 In – An arrival aircraft is parked at the gate 

 In_Queue – A departure aircraft is inside the queue 

detection box of the assigned runway 

 In_Ramp – An arrival is taxiing in the Ramp 

 On – An arrival aircraft has landed 

 On_Final – An arrival aircraft is on final approach 

 Out – A departure has pushed back and/or released brakes 

and is taxiing in the Ramp 

 Pushback – A departure aircraft is pushing back 

 Return_to_Gate – A departure is returning to the gate 

 Scheduled_In – An arrival aircraft has not been tracked by 

STBO yet 

 Scheduled_Out – A departure aircraft has not pushed back 

out yet 

 Suspended – The flight should have already departed and 

no flight updates have been received 

 Taxiing_AMA – A departure aircraft is taxiing on the 

airport movement area 

 Term_Area_Arr – An arrival aircraft is inside the terminal 

airspace 

Gate Gate number assigned to the aircraft by the airline or user 

Gate Conflict Gate and duration of a gate conflict. The values are: 

 Gate 

 Start time 

 Duration in minutes 

Gate Conflicting 

Key 

Unique identifier of the other aircraft that is in conflict with the 

given aircraft  

Gate Source Data source for gate information: 

 AIRLINE – Data comes from the airline 

 DECISION_TREE – The default gate assignment from 

STBO’s decision tree 

 USER – The gate was assigned from an STBO user 

interface  

Gate Time For arrivals, the TIBT prior to reaching the gate and the AIBT 

once the flight arrives at the gate.  

For departures, this is the TOBT prior to a flight pushing back 

from the gate and the AOBT after pushback.  

Prior to the actual time (AIBT or AOBT) the time is prefixed with 

“E” to represent that the time is estimated. 

Ground Stop Displays “Ground Stop” when a flight is subject to a ground stop 
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IOBT Initial Off Block Time set by TFMS. This time is the first off-

block time received for this flight. 

Is Hidden This value is true if the flight’s right-click option for “Delete  

Latitude Latitude of the position of the aircraft in decimal degrees 

LIBT Latest IN Block Time. The estimated time the flight will arrive at 

the gate, sent by the airline either directly or through a 

Collaborative Decision Making (CDM) message to TFMS. 

LOBT Latest Off Block Time. The estimated pushback time received 

from an airline either directly or through a CDM message to 

TFMS. 

Long On Board  Elapsed time that an aircraft has been on the airport surface but 

not at a gate.  

For arrivals, the timer starts when the flight lands (ALDT) and 

stops once the flight arrives at the gate (AIBT).  

For departures, the timer starts when the flight pushes back from 

the gate (AOBT) and ends when the flight takes off (ATOT) or 

returns to the gate. 

Longitude Longitude of the position of the aircraft in decimal degrees 

Metering Group Tactical scheduler group assigned to the departure aircraft based 

on its EOBT and flight state: 

 UNCERTAIN - The data for the departure is less certain 

(i.e. the flight does not have an EOBT, the EOBT is more 

than 10 minutes from current time, or the flight has not yet 

called ready, but was expected to have already called 

ready)  

 PLANNING – The departure has an EOBT and the EOBT 

is within 10 minutes of current time 

 READY – The departure has called ready for pushback 

 OUT – The departure has started pushback but has not yet 

begun taxiing 

 TAXI – The departure is taxiing in the Ramp area or 

AMA 

 QUEUE – The flight is in the queue 

 OFF – The departure has taken off 

 ARRIVAL – The group for all arrival flights 

ModeS International Civil Aviation Organization (ICAO) transponder 

code for Mode-S equipped aircraft 

Origin Airport of origin for departure or arrival aircraft 

Position Source The source of the position data 

 TZ – The track data was received from TFMS 

 SMA – The track data was received from TMA 

 FUSION – The track data was received from ASDE-X or 

AAL’s surface surveillance at CLT 

Prev Tail If a flight’s tail number changes, this is the previous tail number 

assigned to the flight. 
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Ramp Area Indicates the planned or actual general area in the Ramp where 

the aircraft is or will be parked, i.e., B_EAST (B for concourse B 

and EAST for the East side of the concourse) 

Route of Flight  Filed route reported by Federal Aviation Administration (FAA) 

system 

Rwy Estimated (e.g., “E18L”) or actual runway (e.g., “18L”) based on 

flight plan, departure fix, actual location of aircraft, or user input 

Rwy Source Lists the data source that determines the runway: 

 MODEL – The runway is determined by STBO  

 DECISION_TREE – Runway is determined by the STBO 

decision tree  

 STARS – The runway is determined by scratch pad 

entries made in the Standard Terminal Automation 

Replacement System (STARS) 

 UNKNOWN – The source of the runway determination is 

unknown 

Rwy Time The STBO predicted runway time or actual runway time for a 

flight.  

For arrivals, this is landing time.  

For departures, this is takeoff time. 

RwyOpNec Displays “OpNec” when the runway is changed for operational 

necessity 

SDT:TBFM Scheduled Departure Time as accepted in TBFM by the Center 

TMC. This is the scheduled wheels-up time. 

Sector List List of all sectors that a flight has or will travel through from the 

data available to STBO 

SIBT Scheduled In-Block Time. The time the flight is scheduled by the 

airline to arrive at the gate. 

SLDT Scheduled Landing Time. TFMS estimate of when the flight is 

scheduled to land based on the SIBT and future SOBT. 

SOBT Scheduled Off Block Time. The time the flight is scheduled by 

the airline to leave the departure gate. 

Spot Actual or predicted spot for a flight.  E.g. For 11W: 

 11 = spot number 

 W = direction indicator 

Spot Source Indicates the source of data to determine the spot: 

 SURFACE – The spot is determined by the actual spot the 

aircraft used based on surface surveillance 

 DECISION_TREE – The spot is predicted based on 

flight’s gate and runway 

Spot Time The predicted or actual time an arrival or departure will cross the 

spot. For departures, departure metering is assumed to always be 

on when the spot prediction is made. If this column contains the 

prediction, then the time is prefixed with “E” to represent that the 

time is estimated. 
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STA:TBFM Scheduled Time of Arrival by TBFM 

STOT Scheduled Take Off Time. TFMS estimate of when the flight will 

take off based on the SOBT. 

Tail Tail number of aircraft 

Taxi Time The predicted or actual amount of time spent taxiing on the 

airport surface.  

For arrivals, this is the amount of time between landing and 

arriving at the gate.  

For departures, this is the amount of time from pushback to 

takeoff.  

If predicted, the time will be prefixed with an “E” to represent 

that the time is estimated. 

TIBT Target In Block Time. The best prediction of in-block time from 

the ATD-2 tactical scheduler. 

Time in Queue Amount of time that an aircraft has spent in the runway queue 

detection box 

TLDT Target Landing Time from the ATD-2 tactical scheduler. The best 

prediction of landing time. 

TMAT Target Movement Area entry Time from the ATD-2 tactical 

scheduler. The TMAT is the time that a surface-metered 

departure is expected to enter the AMA. 

TOBT Target Off-Block Time from the ATD-2 tactical scheduler. The 

TOBT is the time that a surface-metered flight should push back 

from the gate. Currently, the TOBT is populated for all flights 

whether or not metering is turned on. 

TTOT Target Take Off Time. The best prediction of takeoff time by the 

ATD-2 tactical scheduler. 

TTOT-UTOT Displays the value of TTOT-UTOT 

UIBT Undelayed In-Block Time.  STBO’s predicted in-gate time for a 

single aircraft without consideration of other traffic on the 

surface. 

ULDT Undelayed Landing Time.  STBO’s predicted landing time for a 

single aircraft without consideration of other traffic on the 

surface. 

UMAT Undelayed Movement Area entry Time.  STBO’s predicted spot 

time for a single aircraft without consideration of other traffic on 

the surface. 

Undlyd Off At 

Queue Entry 

UTOT from when the flight enters the queue on the taxiway 

UOBT Undelayed Off-Block Time.  STBO’s best estimate of when the 

flight would be ready to push back in the absence of all external 

constraints, e.g., surface departure metering, EDCTs, Ground 

Stops, APREQ release times. UOBT is based on EOBT, LOBT, 

SOBT, entries in the RTC, and other data elements. 
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UTOT Undelayed Take-Off Time. STBO’s predicted takeoff time for a 

single aircraft without consideration of other traffic on the 

surface. 

 616 

2.4 Toolbar 617 

There are several functions available to the user on the Toolbar (Figure 66). The 618 

following table describes the various Toolbar features from left to right. Toolbar features 619 

that need additional description are (unless otherwise noted) described in sections 0-2.4.4. 620 

Toolbar Feature Description 

TM (Traffic 

Manager) Actions 

Drop-down menu that allows user to schedule/make changes to 

TMIs and runway utilization (see section 0 for details) 

Create Drop-down menu used to add new windows to the interface (i.e., 

Timelines, Tables, and Maps). 

Show Window Drop-down menu used to locate a window that is open but hidden 

from view beneath other windows. 

The Show Window menu will list all of the currently open 

windows, organized by window type (i.e., Timelines, Tables, and 

Maps). The desired window can be selected from these lists and 

will bring the selected window to the forefront of the STBO Client 

display. 

Settings This button opens a window for saving the current display 

configuration for the whole STBO Client or to load a previously 

saved configuration. 

Search Feature Search for flight number, a flight’s callsign, departure fix, or 

destination airport 

New Notification 

Icon/Number 

Provides situational awareness about new notifications 

Notification 

Banner 

This banner cycles through the new notifications in the 

notification table. Once notifications are cleared/acknowledged, 

the banner is blank. Only new notifications are displayed. Clicking 

on the banner populates the notification window. 

Runway 

Utilization Icon 

Provides situational awareness for the airport runway 

configurations and runway utilization 

Ramp Status Icon Provides situational awareness information about Ramp status: 

 Green = Ramp is open 

 Yellow = Ramp closure pending 

 Red = Ramp is closed 

Metering Mode 

Icon 

Provides situational awareness information about what metering 

mode the Ramp is using 
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 621 

 622 

2.4.1 Settings 623 

The “Settings” button on the STBO Client Toolbar can be used to save display 624 

configurations, load previously saved display configurations, adjust settings for 625 

displaying gate conflicts, and enable the clock (Now time) to be displayed on the Map. 626 

The following sections describe each of these settings features. 627 

2.4.1.1 Save/Load Display 628 

To save a user’s display configuration (Figure 67): 629 

 630 

To load a saved display configuration (Figure 67): 631 

 632 

 633 

 

Figure 66. STBO Client Toolbar. 

Step 1: In the “Load/Save Settings” tab, type a name for the display 

configuration in the “File Name:” text box. 

Step 2: Click the “Save” button. This will populate a “Save Settings” 

confirmation window. 

Step 3: Click “OK” to acknowledge that the display configuration has been 

saved. The display configuration file name will now appear in the list of 

“Available Configurations”. 

Step 4: Click “Close” to exit the Settings window. 

Step 1: In the “Load/Save Settings” tab, find the file name under the 

“Available Configurations” list for the desired display configuration. If 

necessary, the list may be scrolled.  

Step 2: Select the desired display configuration file name. 

Step 3: Click the “Load” button. The STBO Client will reload the interface to 

match the selected display configuration file. 

Step 4: Click “Close” to exit the Settings window. 
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 634 

2.4.1.2 Gate Conflicts 635 

In the “Gate Conflicts” tab of the Settings panel, a value can be set for the number of 636 

minutes prior to landing to display gate conflicts for arrival flights. 637 

To set the gate conflict display value (Figure 68): 638 

 639 

 

Figure 67. Toolbar Settings – Save/Load Display. 

Step 1: In the “Gate Conflicts” tab, type a value into the text box or use the up 

and down arrows to select a value for the number of minutes prior to landing 

that the system will display a gate conflict for an arrival flight. 

Step 2: Click the “Apply” button.  

Step 4: Click “Close” to exit the Settings window. 
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 640 

2.4.1.3 Map Clock 641 

The Map clock shows the Map’s update time, which is the Now time. It is the only clock 642 

that can be hidden. 643 

To show/hide the Map clock (Figure 69): 644 

 645 

 646 

 

Figure 68. Toolbar Settings – Gate Conflicts. 

Step 1: In the “Map Clock” tab, select the “Show Map Clock” checkbox to 

show the Map clock or deselect the “Show Map Clock” checkbox to hide the 

Map clock. 

Step 2: Click the “Apply” button.  

Step 4: Click “Close” to exit the Settings window. 
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 647 

2.4.2 Search Feature 648 

The search feature provides the ability to search for flight numbers, callsigns, destination 649 
airports, or departure fixes across the STBO Client interface. The matching flights will be 650 
highlighted on the Timeline, the Map, and in the Flights Table. 651 

To search for information: 652 

 653 

There is no need to click on the Search button. As information is typed in, STBO Client 654 
searches for any flights that matches the query. For example, typing “FDX” will highlight 655 
all FedEx flights. Typing “LGA” will highlight all flights to LGA (Figure 70). Typing 656 
“53” will highlight all flights whose flight number contains “53”, independent of airline. 657 

 

Figure 69. Toolbar Settings – Map Clock. 

Step 1: Type in any string of letter or number for callsigns.  

or 

Step 1: Type a 3 letter airport code for a destination airport. 

or 

Step 1: Type in a departure fix name in full letters.  
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 658 

2.4.3 Notifications 659 

The STBO Client provides notifications in the form of a Notification icon, Notification 660 

banner, and a Notification window (Figure 71). These notifications are generated when 661 

new information is populated in the system. This new information may originate from the 662 

STBO Client or from an outside source, such as SWIM, the FAA’s Operational 663 

Information System (OIS), or other ATD-2 users. Notifications are always related to 664 

events that impact multiple flights or the airport (e.g., Ground Stops, runway closures, 665 

metering events), and are never issued for single flights. For events or restrictions related 666 

to a single flight, the flight’s datablock, properties, and/or entry in the Flights Table are 667 

modified in some way that’s more salient then the standard display of information 668 

(without events or restrictions). 669 

 670 

A list of all notifications for the day can be found in the Notification window. The 671 

notifications list is cleared out each day at 0400.  672 

To access the Notification window: 673 

 674 

 

Figure 70. Search for LGA flights in the Flights Table. 

 

Figure 71. Notification Window. 

Step 1: Click on the Notification banner. The Notification window is now 

populated. 
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When new notifications are received, the Notification icon is yellow and displays the 675 

number of new notifications (Figure 72). The Notification banner will display the subject 676 

of the notification and the time range of the event. When there are multiple new 677 

notifications, the Notification banner will cycle through the unacknowledged 678 

notifications. New notifications are highlighted in yellow in the Notification window.  679 

When notifications are acknowledged, the Notification icon changes to grey and displays 680 

“0” (zero) to represent no new notifications. The Notification window will also remove 681 

all yellow highlighting (Figure 73). The Notification banner not display anything until 682 

new notifications are entered into the system again. 683 

 684 

 685 

To clear new notifications via the Notification icon: 686 

 687 

To clear new notifications via the Notification window: 688 

 689 

 

Figure 72. New Notifications. 

 

Figure 73. No New Notifications. 

Step 1: Click on the Notification icon. All new notifications will clear and the 

icon will change to grey and display “0”. 

Step 1: Click on the Notification banner to populate the Notification window.  

Step 2: Click anywhere inside the window to clear the new notifications. The 

yellow highlighting will disappear. 
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2.4.4 Icons 690 

Three additional icons appear on the Toolbar in addition to the Notifications icon: The 691 

Runway Utilization icon, the Ramp Status icon, and the Metering Mode icon. These icons 692 

provide a quick visual representation of important information for situational awareness. 693 

The Runway Utilization icon (Figure 74) states the current runway utilization in text 694 

format. When the runway utilization and/or configuration information for the airport 695 

change, the text in the Runway Utilization icon updates to reflect this change. 696 

 697 

The Ramp Status icon (Figure 75) is color coded to provide information about the Ramp 698 

status. When the icon is green, the Ramp is open and operational. When the icon is 699 

yellow, the Ramp is pending closure and is using limited operations. When the icon is 700 

red, the Ramp is closed for operations. 701 

 702 

The Metering Mode icon (Figure 76) changes to different images to provide information 703 

about which metering mode the Ramp is currently using to aid in issuing pushback 704 

advisories for flights. In part A of Figure 76, the Ramp is using metering. In part B, the 705 

Ramp is using Departure Sequence Metering. The value inside the icon represents the 706 

total number of flights that can be pushed back and anywhere on the airport surface 707 

before the Ramp Controllers will begin holding flights at the gate. In part C, the Ramp is 708 

using Time-Based Metering. Time-Based Metering uses the ATD-2 automation’s 709 

algorithm for metering at the flights in the Ramp. 710 

 

Figure 74. Runway Utilization. 

 

Figure 75. Ramp Status. 
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 711 

2.5 Flight Properties 712 

The Flight Properties window can be accessed using the flight’s right-click menu from 713 

the Flights Table, Map, and Timeline (“Properties” option in Figure 77). This window 714 

displays flight-specific information for individual flights. Once open, the Flight 715 

Properties window lists the flight’s callsign in the window’s title bar. The following table 716 

describes each of the items in the Flight Properties window.  717 

 718 

Flight Properties Item Description 

Flight ID Callsign of the flight 

 

Figure 76. Metering Modes. 

 

Figure 77. Flight Properties. 
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Status Lists the aircraft state and location: 

 Cancelled – The flight has been cancelled by the 

airline 

 Departed – A departure aircraft is airborne 

 Enroute_Arr – An arrival aircraft is in the enroute 

airspace 

 In – An arrival aircraft is parked at the gate 

 In_Queue – A departure aircraft is inside the queue 

detection box of the assigned runway 

 In_Ramp – An arrival is taxiing in the Ramp 

 On – An arrival aircraft has landed 

 On_Final – An arrival aircraft is on final approach 

 Out – A departure has pushed back and/or released 

brakes and is taxiing in the Ramp 

 Pushback – A departure aircraft is pushing back 

 Return_to_Gate – A departure is returning to the gate 

 Scheduled_In – An arrival aircraft has not been 

tracked by STBO yet 

 Scheduled_Out – A departure aircraft has not pushed 

back out yet 

 Suspended – The flight should have already departed 

and no flight updates have been received 

 Taxiing_AMA – A departure aircraft is taxiing on the 

airport movement area 

 Term_Area_Arr – An arrival aircraft is inside the 

terminal airspace 

Category Arrival or departure 

Runway Runway assignment 

Spot Spot assignment 

Parking Gate Assigned/actual gate for the flight 

Out Time Time a departure flight will/did push off the gate 

Off Time Time a departure flight will/did takeoff from the runway 

On Time Time an arrival flight will/did land on the runway 

In Time Time an arrival flight will/did park at the gate 

Departure Fix Assigned/actual departure fix for a flight (departures only) 

Departure Gate Assigned/actual departure gate for a flight (departures only) 

APREQ Release For flights with APREQ restriction, the APREQ release time 

Route Filed route reported by FAA system 

Taxi Route The remaining route for taxiing across the AMA 
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The “Find” button is a way to locate the flight across the whole STBO Client interface. 719 

When the “Find” button is clicked, the flight’s datablock will highlight on the Timeline, 720 

the Map, and on the Flights Table (Figure 78). 721 

 722 

 723 

 724 

  725 

 

Figure 78. Find function in the Flight Properties window. 
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3 Flights with APREQ/CFR restrictions 726 

This section describes information about APREQs in the STBO Client that is available in 727 

the observer mode. Note that users of the STBO Client in observer mode cannot 728 

participate in the negotiation process for an APREQ release time using STBO Client.   729 

This section assumes that APREQ restrictions have been entered or read into STBO 730 

previously, either read in through SWIM or manually entered in by a user of the STBO 731 

Client in operational mode. If an APREQ restriction is scheduled, e.g. APREQ for flights 732 

to LGA, then a notification about the APREQ has already been published to all ATD-2 733 

users, and the Timeline will have been updated to show “APREQ” on the Timeline 734 

datablocks for all flights with the APREQ restriction (Figure 79). APREQ aircraft will 735 

also be identifiable on the Flights Table (Figure 80) and the Map (Figure 81).  736 

 737 

  738 

 739 

 

Figure 79. APREQ flight on STBO Client Timeline. 

 

Figure 80. APREQ flight on STBO Client Flights Table. 

 

Figure 81. APREQ flight on STBO Client Map. 
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3.1 APREQ Symbols on the Timeline 740 

If there is a "lightning bolt" symbol to the left of the call sign on the Timeline datablock 741 

(Figure 82), it means that electronic coordination of an APREQ release time is available 742 

for the flight. The user of the STBO Client in operational mode can engage in this 743 

electronic APREQ coordination. 744 

 745 

Once the request for release time has been sent to TBFM/IDAC at the Center, a yellow 746 

arrow will appear to the right of the Timeline datablock (Figure 83). 747 

 748 

Once the Center accepts and returns the release time, the assigned release time is written 749 

on the Timeline datablock as “A:####” (e.g., “A:2344”; see Figure 84). The release time 750 

is also highlighted by a compliance indicator (see section 3.2 for more information on 751 

compliance indicators).  752 

 753 

If the Center returns a time that differs from the operational STBO Client user’s 754 

requested release time, a yellow diamond with an exclamation point appears next to the 755 

flight’s datablock on the Timeline (Figure 85).  756 

 757 

If there is a "telephone" symbol to the left of the call sign on the Timeline datablock 758 

(Figure 86), it means that electronic coordination of an APREQ release time is not 759 

available for the flight. 760 

 761 

When the APREQ request or time is cancelled, the APREQ flight’s Timeline datablock 762 

will return to its original state with no APREQ release time or compliance indicator for 763 

the APREQ release time (Figure 87). 764 

 

Figure 82. APREQ flight capable of electronic coordination of release time. 

 

Figure 83. Request for a release time has been sent to Center. 

 

Figure 84. Release time has been returned by Center. 

 

Figure 85. Center returns a different release time then the time requested. 

 

Figure 86. APREQ flight is not capable of electronic coordination of release time. 
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 765 

3.2 Compliance Indicators 766 

Compliance indicators are used to show the status of a flight’s compliance with its release 767 

time. Flights can be assigned both APREQ and EDCT release times, and therefore each 768 

release time has its own compliance indicator (Figure 88).  769 

  770 

The following table outlines the different colors of the compliance indicators: 771 

Compliance Indicator 

Color 

Description 

Green The flight is projected to be released from the runway in 

compliance with its release time window. 

Yellow The flight is projected to not be released from the runway in 

compliance with its release time window and to be released 

early. 

Red The flight is projected to not be released from the runway in 

compliance with its release time window and to be released 

late. 

 772 

  773 

 

Figure 87. APREQ flight returned to original state after APREQ is Cancelled. 

 

Figure 88. Compliance indicators. 



 

ATD2_1029_v1_STBO_Client_Obs_UM last updated 15 Sep 2017 page 77 of 80 

Appendix A: Acronyms 774 

This appendix defines acronyms and terms that are used repeatedly throughout  775 

the ATD-2 STBO Client User Manual. 776 

 777 

Acronym Term 

!= Does not equal or not equal to 

AAL American Airlines 

AC Aircraft 

ACID Aircraft Identifier 

ACK Acknowledge 

ADW Arrival / Departure Window 

AFP Airspace Flow Program 

AIBT Actual In Block Time 

ALDT Actual Landing Time 

AMA Airport Movement Area 

AMAT Actual Movement Area entry Time 

AOBT Actual Off Block Time 

APREQ / 

CFR 

Approval Request / Call For Release 

ARR / DEP Arrival / Departure 

ARRFIX Arrival Fix 

ARTCC Air Route Traffic Control Center 

ASDE-X Airport Surface Detection Equipment - Model X 

ATC Air Traffic Control 

ATCT Air Traffic Control Tower 

ATD-2 Airspace Technology Demonstration 2 

ATOT Actual TakeOff Time 

BOS Boston Logan International Airport 

CC Configuration Change (Runway) 

CDM Collaborative Decision Making 

CDR Coded Departure Route 

CLT Charlotte Douglas International Airport 
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CSV Comma-Separated Values (file type) 

CTOP Collaborative Trajectory Options Program 

CTOT Controlled TakeOff Time 

DAL Delta Air Lines 

DB DataBlock 

DEPFIX Departure Fix 

DEST Destination 

DFW Dallas / Fort Worth International Airport 

EDCT Expected Departure Clearance Time 

EFTT Earliest Feasible Takeoff Time 

EOBT Earliest Off-Block Time 

ESTIBT Estimated In-Block Time 

ESTOBT Estimated Off-Block Time 

ETA Estimated Time of Arrival 

ETD Estimated Time of Departure 

FAA Federal Aviation Administration 

FDX FedEx 

FUSION Consolidates all available airport surveillance  

to simulate a single-sensor radar display system  

GDP Ground Delay Program 

GS Ground Stop 

HSV;  

HSL;  

RGB;  

CMYK 

COLOR MODELS:  

Hue, Saturation, Value;  

Hue, Saturation, Lightness;  

Red, Green, Blue;  

Cyan, Magenta, Yellow, Key (Black) 

ICAO International Civil Aviation Organization  

ID Identification 

IDAC Integrated Departure Arrival Capability 

IOBT Initial Off-Block Time 

LGA LaGuardia International Airport 

LIBT Airline In Block Time 

LOB Long On Board 
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LOBT Airline Off Block Time 

MIT Miles-In-Trail 

NASA The National Aeronautics and Space Administration 

nmi Nautical miles 

OIS FAA Operational Information System 

OPNEC Operational Necessity  

REQ Request 

RMTC Ramp Manager Traffic Console 

RTC Ramp Traffic Console 

RWY Runway 

SDT Scheduled Departure Time 

SIBT Scheduled In Block Time 

SID Standard Instrument Departure 

SLDT Scheduled Landing Time 

SMA Surface Movement Advisor 

SOBT Scheduled Off-Block Time 

STA Scheduled Time of Arrival 

STAR Standard Terminal Arrival Route 

STARS Standard Automation Replacement System 

STBM Surface Time-Based Metering 

STBO Surface Trajectory Based Operations 

STOT Scheduled Take Off Time 

SWIM System-Wide Information Management 

TBD To Be Determined  

TBFM Time-Based Flow Management System 

TFDM Terminal Flight Data Manager 

TFM Traffic Flow Management 

TFMS Traffic Flow Management System 

TIBT Target In Block Time 

TLDT Target Landing Time 

TM Traffic Management 
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TMA Traffic Management Advisor 

TMAT Target Movement Area entry Time 

TMI Traffic Management Initiative(s) 

TOBT Target Off-Block Time 

TRACON Terminal RADAR Approach Control 

TTOT Target Take Off Time 

TZ Track data from TFMS 

UAL United Airlines 

UIBT Undelayed In Block Time 

ULDT Undelayed Landing Time 

UMAT Undelayed Movement Area entry Time 

UNK Unknown 

UOBT Undelayed Off-Block Time 

UTOT Undelayed Take Off Time 

 778 

 779 


